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Figure 1   2-Port Banded Millimeter-Wave Configuration (N5261AH60)

Introduction

This document describes system installation and operation of the 
N5261AH60 Millimeter Head Controller.
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Description
The N5261AH60 Millimeter Head Controller was designed for use with the 
E836xA/B/C PNA network analyzer family and banded millimeter-wave system 
solutions. Banded millimeter-wave systems are made up of three types of 
major components: a PNA, a controller test set, and two millimeter-wave 
heads. These components are generally purchased separately and assembled 
into a system at the customer's site. 

Key features of the N5261AH60:

— Primarily designed for use with E836xA/B/C PNA products with Option H11

— Designed to electrically emulate the legacy N5260A Millimeter-wave Test 
Set Controller

— Pulsed measurement capability not provided

— The N5250x Broadband systems (10 MHz to 110 GHz) are not supported

Table 2 on page 4 lists compatible PNA models with required options. Table 6 
on page 15 and Table 7 on page 15 list available millimeter-wave modules. A 
typical system configuration is pictured in Figure 1 on page 1.

In this document the N5261AH60 will be referred to as the Test Set.

This manual should be used in conjunction with the following documents:

— PNA Series Network Analyzer On-line Help System 

— Millimeter-wave Technical Overview 5989-7620EN 

— OML Millimeter-wave modules (N5256-90001)

— VDI Millimeter-wave modules (N5256-90002)
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Verifying Your Shipment
To verify the contents shipped with your product, refer to the “Box Content 
List” included with the shipment. 

Inspect the shipping container. If the container or packing material is 
damaged, it should be kept until the contents of the shipment have been 
checked mechanically and electrically. If there is any physical damage, refer 
to “Contacting Keysight” on page 70. Keep the damaged shipping materials 
(if any) for inspection by the carrier and a Keysight Technologies 
representative. 

The N5261AH60 Millimeter Head Controller and the millimeter-wave 
modules are sensitive to electrostatic discharge (ESD). Ground your 
work station before unpacking and installing the millimeter-wave 
modules. See “Electrostatic Discharge Protection” on page 69.

Test Set Accessories

Use the tables below to verify that your shipment is complete. 

Table 1 N5261AH60 Standard Content 

√ Keysight 
Part Number

Description Qty

1250-3975 Connector Adapter, BNC f/SMA m 4

1810-0118 Coax Termination, 50 Ohm, male (load) 1

5061-9038 RF Cable Assy, SMA m/m 2

8120-1839 IF Cable Assy, BNC m/m 4

9230-0333 Envelope (Calibration Certificate) 1

9320-6636 Functional Certificate 1

N4011-21002 Test Set to PNA I/0 Interface Cable - DSub25 m/m, 
520mm (20in)

1

N5261-90001 User’s and Service Guide 1

N5261AH60 Millimeter Head Controller Test Set 1
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Network Analyzer Requirements
The PNA Network Analyzer should be updated to the latest firmware. For 
firmware updates, go to: 
http://na.support.keysight.com/pna/firmware/firmware.html

System Configurations
Table 1 documents all supported Network Analyzer configuration options for 
banded mm-wave systems using the N5261AH60 test set.

The Test Set will require a Hardware Lock-Link Kit and a Millimeter 
Module Cable Interface Kit (U30215 opt 030). Refer to “Hardware Lock-
Link Installation (U3021-60001)” on page 19.

General Specifications

Table 2 PNA Based Configurations 

PNA Models PNA Options Test Set SRC Connects Cable 
Configuration 
Diagrams

E8361A
E8362/3/4B
E8361/2/3/4C

H11, 080 N5261AH60 Rear Fig. 12, Page 22

Environmental:

Temperature 

Altitude

Power Requirements: Nominal 

Frequency Range 

Nominal Voltage Range 

AC Power Max.

Weight and Dimensions: 

Net Weight

Dimensions

20 to 30 °C

9,842 ft

50/60 Hz

100/120/220/240 Vac

350 Watts

10 kg (22 lb)

Height: 18 cm (7.1 in)   
Width: 42.5 cm (16.75 in)
Depth: 42.5 cm (16.75 in)
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This product is designed for use in Installation Category II and Pollution 
Degree 2.

Required Conditions for Accuracy Enhanced Measurement

Accuracy-enhanced (error-corrected) measurements require the ambient 
temperature of the Millimeter Wave measurement system to be maintained 
within ± 1 °C of the ambient temperature at calibration.

The instrument can safely operate in a relative humidity of 80% for 
temperatures to 31 degrees C, decreasing linearly to 50% relative humidity at 
40 degrees C.

Ventilation Requirements: When installing the instrument in a cabinet, the 
convection into and out of the instrument must not be restricted. The ambient 
temperature (outside the cabinet) must be less than the maximum operating 
temperature of the instrument by 4 °C for every 100 watts dissipated in the 
cabinet. If the total power dissipated in the cabinet is greater than 800 watts, 
forced convection must be used.

Table 3 Characteristics and Specifications 

Front/Rear Panel Connector1 Power Levels (dBm) Gain Frequency 

Min Typ Max2

N5261AH60

TEST or REF IF (Input) (characteristic) − −27 −10 − 8.33 MHz

TEST IF to A/B/C/D IF OUTPUT (specification) 
See Figure 35 on page 57.

− − − −1.5 dB (± 1) 8.33 MHz

REF IF to A/B/C/D IF OUTPUTS (specification) 
See Figure 36 on page 57.

− − − −1.5 dB (± 1) 8.33 MHz

REF IF to R IF OUTPUTS (specification) 
See Figure 35 on page 57.

− − −1.5 dB (± 1) 8.33 MHz

LO IN (characteristic) −10 − 2 − 1.7 to 20 GHz

LO OUT (specification)3 
See Figure 34 on page 55.

7 10 12 >14.5 dB 1.7 to 20 GHz

SRC1 RF IN (characteristic) -16 − 5 − 1.7 to 20 GHz

RF OUT (specification)4
See Figure 35 on page 57.

1. All connectors are SMA female.
2. Do not exceed the maximum level or damage may occur.
3. With a −3 dBm Input, measure on the test set connector. See Figure 34 on page 55.
4. ALC on and with 0 dBm Input, measure on the test set connector. See Figure 35 on page 57. 

7 10 12 >14.5 dB 1.7 to 20 GHz
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Front Panel Features

Figure 2 N5261AH60 (2-Port) Front Panel Features

LO Out  Port Status LEDs

RF Out

Ref IF

Test IF

Standby Switch      Over Current LEDs DC Power

  
  
Active
LED
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TEST IF

IF signal input connection from the millimeter module’s Test or Measure IF 
Output. 

REF IF

Reference IF signal input connection from the millimeter module’s Reference IF 
Output.

RF OUT

Provides an amplified RF source signal to the millimeter-wave module’s RF 
Input.

LO OUT

Provides amplified LO signal to the millimeter-wave module’s LO Input.

Port Status LEDs

The amber LEDs indicate which source port is active. The green LEDs indicate 
which receiver port is active. In normal operation both receiver LEDs are always 
ON.

DC Power (Bias)

This bias supplies the +12 Vdc and ground lines for OML millimeter-wave 
modules. Pins 1 and 3 are both +12 Vdc supplies. Pins 4 and 6 are the dc 
supply ground lines. Pins 2, 5, and 7 are unused. The DC power connections 
are intended for use with OML modules.

DC Power/Over Current LEDs

The green LEDs indicate that the DC power bias is on. The amber LEDs 
indicate an over current condition.

Standby Switch

The switch is only a Standby switch, not a AC line power switch. 

Active LED

When the test set is connected and addressed by a analyzer, the LED is On 
(illuminated). The LED is Off (not illuminated) when the test set is in Standby, 
or not addressed by the analyzer.
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Rear Panel Features

Figure 3 N5261A Rear Panel Features

 Line Module   Test Set I/O    Pass Thru Interface Chassis Ground  

IF Outputs D, C, B, A LO IN SRC1 IN/OUT
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IF OUTPUTs – SMA (female)

— D (from the test set to the analyzer’s IF R2 Input)

— C (from the test set to the analyzer’s IF R1 Input)

— A (from the test set to the analyzer’s IF A Input)

— B (from the test set to the analyzer’s IF B Input)

LO IN

This input is from the LO drive of the analyzer. The signal is split and amplified 
and then output to the front panel of the N5261AH60.

SRC 1 RF IN

Test set rear panel RF Input access for use with the analyzer’s SRC 1 provides 
the power input for RF OUT Ports 1 & 2.

Chassis Ground

A threaded terminal post for connecting the test set to a conductive object, 
cabinet or structure to ensure a common potential and reduce leakage current 
in a system. Requires an English 1/4-20 thread nut (0140-0084) and lock 
washer (2190-0067).   

Pass Through Interface

Connection to another test set.

Test Set I/O

The test set interface connector is used to send address and data to the test 
set from the analyzer.

Line Module

This assembly houses the line cord connection, line fuse, and line voltage 
selector. Remove the line module cover to replace or change the fuse. Line 
voltage selection is automatic and no setting is required. Recommended fuse 
values are printed on the rear panel of the N5261H60.

Power Cords

A line power cord is supplied in one of several configurations, depending on 
the destination of the original shipment. Keysight can supply additional 
certified power cords to meet region electrical supply and receptacle 
configurations. Please refer to our website at: http://www.keysight.com for 
assistance in power cord selection. 

http://www.keysight.com/main/home.jspx?cc=US&lc=eng
http://www.keysight.com/main/home.jspx?cc=US&lc=eng
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Available Fuses

—  Fuse (F 5 A/250V, 2110-0709) UL listed and CSA certified.

For continued protection against fire hazard replace line fuse only with 
same type and rating. The use of other fuses or material is prohibited.

Figure 4 Line Fuse 

Verify that the premise electrical voltage supply is within the range specified 
on the instrument.
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System Accessory Information
The following tables provide information on available measurement system 
interface options.

Table 4 Test Set to the Module Cable Set Options (Sold Separately) 

√
Keysight 
Part Number

Description Qty

N5261A Option 501 (1-Port Trans/Refl Cable Set (48 inches = 1.2 meter))

1250-2604 Coax Connector Adapter, right angle- SMA m/f 2

8121-1221 Coax flex CA-Assy, 3.5 mm male to male, 1.2 m (48 in) - RF & LO 2

85105-60030 Multi-Cond Flex CA-Assy, Cir 7C, 1.2 m (48 in) - DC Power Bias 1

85105-60048 Coax flex CA-Assy, right angle- SMA m/m 1.2 m (48 in) - Ref & Test IF 2

N5261-60019 Cable Sleeve and Marker Kit, 1.2 m (48 in) 1

N5261A Option 502 (1-Port Trans/Refl Cable Set (79 inches = 2 meter))

1250-2604 Coax Connector Adapter, right angle- SMA m/f 2

N5260-60023 Coax flex CA-Assy, 3.5 mm male to male, 2 m (79 in) - RF & LO 2

N5260-60070 Coax flex CA-Assy, right angle SMA m/m, 2 m (79 in) - Ref & Test IF 2

N5260-60025 Multi-Cond Flex CA-Assy, Cir 7C, 2 m (79 in) - DC Power Bias 1

N5261-60020 Cable Sleeve and Marker Kit, 5 m (197 in) 1

N5261A Option 503 (1-Port Trans/Refl Cable Set (118 inches = 3 meter))

1250-2604 Coax Connector Adapter, right angle- SMA m/f 2

N5260-60026 Coax flex CA-Assy, 3.5 mm male to male, 3 m (118 in) - RF & LO 2

N5260-60027 Coax flex CA-Assy, right angle SMA m/m, 3 m (118 in) - Ref & Test IF 2

N5260-60028 Multi-Cond Flex CA-Assy, Cir 7C, 3 m (118 in) - DC Power Bias 1

N5261-60020 Cable Sleeve and Marker Kit, 5 m (197 in) 1

N5261A Option 505 (1-Port Trans/Refl Cable Set (197 inches = 5 meter))

1250-2604 Coax Connector Adapter, right angle- SMA m/f 2

N5260-60029 Coax flex CA-Assy, 3.5 mm male to male, 5 m (179 in) - RF & LO 2

N5260-60071 Coax flex CA-Assy, right angle SMA m/m, 5 m (179 in) - Ref & Test IF 2

N5260-60072 Multi-Cond Flex CA-Assy, Cir 7C, 5 m (197 in) - DC Power Bias 1

N5261-60020 Cable Sleeve and Marker Kit, 5 m (197 in) 1
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Table 5 Test Set Rackmount Front Handle Kit Options (Sold Separately) 

√
Keysight 
Part Number

Description Qty

N5262A Option 1CM (Rackmount Kit without Front Handles)

5063-9215 Rackmount Kit - 177.OH-without Handle 1

N5262A Option 1CN (Front Handle Kit)

5063-9228 Front Handle Kit - 177.OH 1

N5262A Option 1CP (Rackmount Kit with Front Handle Kit)

5063-9222 Rackmount Kit with handle- 177.OH 1
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Compatible Millimeter-wave Modules
Keysight offers millimeter modules manufactured by Olsen Microwave Labs 
(OML) and Virginia Diodes Inc (VDI) for use with the N5261AH60 for banded 
mm-wave network analyzer systems. Refer to Table 6, “Available OML 
Modules,” on page 15 and Table 7, “Available VDI Modules,” on page 15.

Transmission/Reflection millimeter-wave modules contain an RF source 
multiplier, dual directional coupler, reference downconverter and a test 
downconverter. The Transmission/Reflection millimeter-wave module is 
usually the primary module of a millimeter-wave VNA system. A single 
Transmission/Reflection module allows the measurement of S11 reflection 
coefficient only. Refer to Figure 5.

“Receive only” millimeter-wave modules contain a test downconverter to 
receive the test signal from a Transmission/Reflection millimeter-wave module. 
The use of a Receiver module, as the second module, allows the system 
capability to measure S11 and S21 only.

The use of two Transmission/Reflection modules in the millimeter-wave VNA 
system allows for all four S-parameters to be measured. The test down 
converters of Transmission/Reflection modules are the receivers for the signal 
from the modules sources. When the two modules waveguide are connected, 
S11 and S21 are measured in the forward direction, S22 and S12 are measured 
when the signal path is reversed. If a 4-Port system is configured with 
Transmission/Reflection modules, all 16 S-parameter measurements can be 
made on a 4-Port device.



14   Keysight N5261AH60 User’s and Service Guide

Installation & System Operation

-

Figure 5 Module Configurations
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Table 6 Available OML Modules1 2

Banded Freq 
Ranges (GHz)

Port Type Source Receiver Model # Notes

33 to 500 Waveguide √ √ N5256AWxx T/R Module

33 to 500 Waveguide √ N5257ARxx Receiver

33 to 500 Waveguide Dual N5258ADxx Receiver-Dual

1. The Interface cable set is not supplied.
2. Adjustable RF Attenuator, RF & LO internal amplifiers options are available. Refer to OML millimeter-wave modules 

documentation (N5256-90001).

Table 7 Available VDI Modules1 2 

Banded Freq 
Ranges (GHz)

Port Type Source Receiver Model # Notes

750 to 1100 Waveguide √ √ N5262AW01-TST T/R Module

500 to 750 Waveguide √ √ N5256AW01-TST T/R Module

50 to 500 Waveguide √ √ N5262AWxx-TST T/R Module

750 to 1100 Waveguide √ N5262AR01-TST Receiver

500 to 750 Waveguide √ N5256AR01-TST Receiver

50 to 500 Waveguide √ N5262ARxx-TST Receiver

1. The Interface cable set is supplied with each VDI module. Do not order cable Options 501, 502, 503 and 505.
2. These modules are compatible with the test set only. They are provided with their own power supply, do not connect to the 

test set DC power port. Refer to VDI millimeter-wave modules documentation (N5256-90002). 
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Cable Loss Between the Test Set and the Module
If the cables between the test set and the millimeter-wave modules are longer 
than four feet, cable loss for the RF and LO paths may be excessive. Perform 
the analysis recommended below. 

Determine the input power level requirements for the millimeter-wave module 
selected for use. Refer to the documentation included with your module. To 
determine the power available at the module, calculate the cable loss using 
Figure 6 or Table 8, then subtract the cable loss from the RF and LO Out 
characteristic power of 10 dBm. You may also use a power meter. 

A separate DC supply is recommended for OML modules if they are greater 
than 5 meters from the controller. A DC bias power cable, with banana plug 
connectors, is available for use with a separate power supply such as E3615A 
for OML modules. VDI modules have a DC power supply included with the 
module.

If you are installing an external amplifier in the LO or RF path, ensure the 
amplifier’s input is connected to the test set, and the output is connected to 
the mm-wave module’s LO or RF Input. Modules with internal amplifiers are 
available. 

Table 8 Typical Cable Insertion Loss (N5261A Options)

Cable Option Cable Length 7 GHz 10 GHz 18 GHz

501 4 ft. (1.22 m) 1 dB 1.2 dB 1.6 dB

502 6.58 ft. (2 m) 1.65 dB 2 dB 2.65 dB

503 9.83 ft. (3 m) 2.5 dB 3 dB 4 dB

505 16.4 ft. (5 m) 4.1 dB 5 dB 6.6 dB
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Figure 6 Typical RF Cable Loss (dB loss per foot)
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System Configuration and Operation

Site Preparation

Install the instrument so that the detachable power cord is readily identifiable 
and is easily reached by the operator. An externally installed switch or circuit 
breaker (which is readily identifiable and is easily reached by the operator) 
should be used as the disconnecting device.The detachable power cord can 
also be used to disconnect the mains circuits from the mains supply before 
other parts of the instrument. The front panel switch is only a standby switch 
and is not a LINE switch. 

Protect Against Electrostatic Discharge (ESD)

This is important. If not properly protected electrostatic discharge can seriously 
damage your analyzer, resulting in costly repair.

To reduce the chance of electrostatic discharge, follow all of the 
recommendations outlined in “Electrostatic Discharge Protection” 
on page 69.

Table 9  Power Requirements of a Standard Configuration

Standard Equipment

Instrument Maximum Watt 

N5261AH60 Millimeter Head Controller 350

Millimeter-wave Module (OML) (powered from controller)

Millimeter-wave Module (VDI) 175
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Hardware Lock-link Installation (U3021-60001)
If your system is to be rack mounted, this installation procedure does not have to be 
performed.

The opening of covers or removal of parts is likely to expose dangerous voltages. 
Disconnect the instrument from all voltage sources while it is being opened.

Locking and Test Set to the PNA 

1. The lock-link kit (U3021-60002) includes:

• 5023-9253 - Lock-link kit (left, 5022-2816 & right 5022-2817), Test Set

• 5023-0132 - Lock-link kit (left, right and screws), Analyzer

2. Remove the feet from the bottom of the analyzer.

3. Remove the 2 lower standoffs on the rear panel of the analyzer using a T20
Torx driver.

Figure 7 Rear Bottom Feet

4. Install the lower lock-links (left not shown) onto the analyzer.

Standoffs (x2)

Feet (x4)
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Figure 8 Install Lock-links to the Analyzer

5. Remove the two upper standoffs on the rear panel of the test set using a
T20 Torx driver.

6. Install the left and right lock-links onto the test set.

Figure 9 Rear Lock-links to the Test Set

Screws (0515-1619)
T20 M4X0.7 25 mm

Right lock-link
5023-0132 (pair)

Right lock-link  Left lock-link 

5022-2816            5022-2818 

Screw 0515-1244 (x2)
T20 M3.5X0.6  12 mm
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7. Place the analyzer on top of the test set and ensure that the front frame of
the analyzer is positioned slightly forward of the locks that are attached to
the test set. Slide the analyzer back so the locks engage the front frame of
the analyzer.

Figure 10 Locking the Analyzer

8. Secure the analyzer’s lower lock-links to the test set’s upper lock-link using
the spring–loaded screws. If the analyzer's lock-links are not aligned with
the screw holes, loosen the screws securing the feet to the instrument to
align and tighten.

Figure 11 Lock-Link Secured

Test Set
Front Frame

Network Analyzer
Front Frame

Slide the network Analyzer
back to engage the lock link
in the back of the network
analyzer's front frame

Lock Link
screw

Slide the network analyzer
back to engage the lock link in 
the back of the network 
analyzer’s front frame,
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Figure 12 PNA to Test Set Connections 

E8361C PNA

Network Analyzer

with Option H11

RF LO
B R2

Test Set Interface

A IF

R1 IF

AR1

E8361C PNA

Network Analyzer

with Option H11

N5261AH60
Millimeter Head

Controller

D LO IN

RF LO
B R2

Test Set Interface

B

Pass Thru

Interface

R
--------- IF Outputs ----

Adapter x4

SMA(m) / BNC(f)

A IF

R1 IF

R2 IF

B IF

AR1

C A

Test Set I/O

SRC 1
RF IN
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Millimeter-wave Module Cable Connections 

Before connecting the millimeter-wave modules, verify that the test set and the 
power supplies (if used) are powered down.

There are four RF cables for each T/R module. Cables provided with the VDI 
modules are pre-labeled. The cables for use with the OML modules come in 
two types, two lighter and two heavier. Use the lighter cables for the IF signals 
and the heavier cables for the RF and LO signals.

Figure 13 Example of OML Module Connections

DC Bias
REF IF

TEST IF

RF

Keysight N5261AH60 Millimeter Head Controller

Port 1 Port 2

LO

RF OUT LO OUT

REF IF

(R1)

TEST IF

(A)

RF OUT LO OUT

REF IF

(R2)

TEST IF

(B)

DC

POWER

DC

POWER

Port 2Port 1

Reference 2

Port 2RCVR

B IN

CPLR

ARM

SOURCE

OUT

CPLR

THRU

SOURCE

OUT

RCVR

R2 IN

Reference 1

Port 1 RCVR

A IN

CPLR

ARM

SOURCE

OUT
CPLR

THRU

SOURCE

OUT

RCVR

R1 IN

PNA Network Analyzer

OML
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Figure 14 Example of VDI Module Connections

I

O

Power Supply

Port 2Port 1

Reference 2

Port 2RCVR

B IN

CPLR

ARM

SOURCE

OUT

CPLR

THRU

SOURCE

OUT

RCVR

R2 IN

Reference 1

Port 1 RCVR

A IN

CPLR

ARM

SOURCE

OUT
CPLR

THRU

SOURCE

OUT

RCVR

R1 IN

PNA Network Analyzer

Keysight N5261AH60 Millimeter Head Controller

REF IF

(R2)

TEST IF

(B)

DC

POWER

LO OUTRF OUT

Port 2

REF IF

(R1)

TEST IF

(A)

LO OUTRF OUT

Port 1

REF IF

MEAS IF

RF
LO

VDI

Power 
Supply

VDI

Power 
Supply



Keysight N5261AH60 User’s and Service Guide    25

Installation & System Operation

The following detailed instructions are for connecting an OML T/R module. 
These instructions assume a cable dress kit (black sleeving) is available. Modify 
the instructions appropriately for other types of modules.

1. Prepare the cable bundle comprised of five cables listed in Table 10.

a. Complete Steps 1 through 5 of the Installation Guide from the
Millimeter-wave Cable Dress Kit (document number N5260-90070
contained in kit part number N5261-60019). DO NOT APPLY THE
VELCRO ASSEMBLIES AT THIS TIME.

2. Connect the five cables to the front panel of the controller in the following
order. Use two right angle adapters (1260-2604).

Figure 15 Controller Front Panel Connections

3. Repeat step 1 and step 2 for each module in the system.

Table 10 Controller Connections

Order Test Set Module (OML)

1 DC POWER +12 V

2 TEST IF Test I.F.

3 REF IF Ref I.F.

4 RF OUT R.F. In

5 LO OUT L.O. In
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4. Select a Millimeter-wave module and place it on the work surface in front
of the test set.

5. Connect the bundle of cables to the module in the following order.

Figure 16 Test Head Module Connections

6. Repeat step 4 and step 5 for the remaining modules.

7. Apply Velcro assemblies to the ends of the cable sleeves.

a. Complete steps 6, 7 and 8 of the Installation Guide from the
Millimeter-wave Cable Dress Kit (document number N5260-90070
contained in kit part number N5261-60019 and N5261-90020).

8. Position each test head in the approximate location where it will be used
for measurement operations.

9. Torque all RF connections to 8 in-lb.

Table 11 Millimeter Head Connections

Order Module (OML)

1 +12 V

2 R.F In

3 L.O. In

4 Ref I.F.

5 Test I.F.
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Configuring the Network Analyzer Firmware

This section will describe how to set up and operate the Test Set Millimeter 
Head Controller with your network analyzer. 

The Test Set Millimeter Head Controller is considered a “slave” instrument. A 
network analyzer must be used to control the test set. 

Before turning on this instrument, verify that the AC supply voltage is in the 
specified range.

Typeface Key Conventions

The following key conventions are used throughout this document.

— [HARDKEYS] are labeled front panel keys.

— SOFTKEYS are indicated on the instrument display.

Before Beginning this Section

Determine the multiplier factors to use for RF IN and LO IN. The factors for 
each head are indicated on the labels located on the top of each head (near 
the RF and LO connectors).

The maximum frequency of RF signals from the PNA rear panel is 19 GHz.
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Millimeter Mode 

The Millimeter mode allows you to configure the system for the 
millimeter-wave module you are using. Refer to the analyzer’s Help menu for 
more information. 

The following instructions assume the system has not been configured for the 
desired heads.

1. Connect your system and turn on all of the equipment.

2. To access the millimeter application select [System] > Configure >
Millimeter Module Config...

Figure 17 Millimeter Modular Configuration Selection

Figure 18 Millimeter Modular Setup
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Figure 19 Millimeter Modular Setup 

3. Enter the RF Multiplier number and LO Multiplier number.

4. Enter the Module Start and Stop Frequency.

Figure 20 Millimeter Modular Setup 

5. Click the New command button. In the Config Name entry dialog box,
enter a title for the module then select [OK].
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Figure 21 Millimeter Modular Setup 

6. When the newly entered Module is highlighted in the configuration list,
select [Activate Selected Config].

Figure 22 Millimeter Modular Setup 

7. Select [OK] when the PNA application restart prompt appears.
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Figure 23 System Operation Verification 
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System Operation Verification

— The Banded System Check verifies the configured system is operating 
correctly. It requires all system components. 

— If a problem is suspected with the test set, refer to “Service Information” on 
page 37 and “Troubleshooting the Test Set” on page 47. 

Banded System Check

The Banded System operational verification procedure confirms that the 
system is operating correctly. There are no hard specifications for the system 
measurement performance, but guidelines are provided for evaluating the 
system operation results. 

The purpose of the Operation Check is to detect significant degradations in the 
system that make the performance unacceptable. The calibration kit and test 
environment can affect the System Operation Check results. Refer to “Site 
Preparation” on page 18.

When any part of the operator’s check provides unsatisfactory results, refer to 
“Troubleshooting, RF Level” on page 50 to determine the cause of the 
problem.

Required Equipment

— Waveguide  Short

— Data for your mm-wave modules receivers

— 3/32 Ball Driver (OML), or 5/64 Ball Driver (VDI)

— 5/16 Open end Torque Wrench, 8 in-lb.

PNA Settings

— 401 Points: [Sweep] > Number of Points > 401

— 1 KHz IFBW: [Sweep] > IF Bandwidth > Use down/up arrow buttons to set 
1.00 KHz. [OK]
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Preparing the Network Analyzer

1. Connect the analyzer, test set and the millimeter-wave band modules as
described in “System Configuration and Operation” on page 18.

2. Turn on the test set and the analyzer.

3. Configure the analyzer for operation with the millimeter-wave modules.
Refer to “Configuring the Network Analyzer Firmware” on page 27. Refer
to the Help menu for further information.

Procedure

This procedure assumes that you have a Transmission/Reflection module on 
each port. If not, the procedure will have to be modified appropriately.

The Operational Check procedure verifies that the banded system is connected 
correctly and the modules, test set and analyzer are operating properly. 

1. Allow the system to warm up for at least 30 minutes.

2. Attach a waveguide extension section to each module’s waveguide flange
port to protect the modules waveguide connector.

3. Verify that the analyzer is in Millimeter mode and that the frequency range
is correct for the configured millimeter system.

4. To verify the port as a receiver, perform the following steps:

a. Connect a short to Port 1.

b. Display all receivers on the analyzer’s screen using the following
menu selections: [System] > Service > Utilities > Receiver Display.

http://www.omlinc.com/vector/vmodules.htm
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Figure 24 Millimeter Modular Setup 

c. Compare the A,1 and R1,1 traces to the data for your modules Test
and Reference receivers. The general shape should be similar, but
not necessarily identical to the graphics in the module
documentation. Depending on the PNA model used, there may be a
level shift of up to 10 dB. If a waveguide short is not connected the
Test Receiver level will appear to have low amplitude.

d. If you are using more than one Transmission/Reflection module
move the short to Port 2. If you are only testing one port proceed to
step 6.

e. Compare the B,2 and R2, 2 traces to the data for your modules Test
and Reference receivers for the millimeter-wave module on Port 2.
The general level and shape should be similar.

f. Select each displayed trace window and delete that trace by Trace >
Delete Trace.
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Figure 25 Example: Banded Receiver Display 

6. Select Trace > New Trace... and select the Receivers Tab. Check the
Numerator A and R1 > [OK].

Figure 26 Example: Two Stack Window Display 

7. Next, setup a two stack window display by: Window > Arrange > Stack 2
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Procedure Failures 

If the System Operation Verification procedure fails, perform the 
following procedure to isolate the problem. 

Refer to the Keysight PNS Series: Firmware, Upgrades, and Support 
at: http://na.support.keysight.com/pna for further information.

To request service, please contact your local service center. In the US, call 
800-829-4444. For a listing of service centers worldwide, please visit us at 
http://www.keysight.com/find/service.

1. Confirm that each piece of equipment is turned on, and all analyzer, and
Module connections are correct.

2. Verify that the analyzer has the correct options for Millimeter mode
operation. Refer to “Network Analyzer Requirements” on page 4.

3. Verify that the analyzer is in Millimeter mode for the waveguide band of
the modules used.

4. If the receiver levels (A,B, C, D or R 1) fail the Banded System check refer
to the Measure, Test and Reference graphs in the documentation included
with the module. If the REF IF and Test IF levels are low connect the REF IF
and TEST IF cables directly from the mm-wave module to the analyzer’s
rear panel IF Inputs. If the levels are correct proceed to step 7. If the levels
are low continue with step 5.

5. If one of the ports are working, substitute the mm-module with a known
working module. If the port is still not working, measure the RF Out and LO
Out power from the test set’s RF Out and LO Out connectors at the end of
the cables. Replace or substitute the cables if the loss is greater then the
cable specification. If the cables are not the cause, proceed to step 7.

Turn off the test set before disconnecting or reconnecting the modules.

6. Confirm that the analyzer is working properly by disconnecting it from the
test set and performing an Operation Verification (OP VER) in the Help
menu.

7. If the analyzer is operating properly, verify the test set by performing the
“Service Information” on page 37. If the test fails, continue to
“Troubleshooting the Test Set” on page 47.

8. If the analyzer, test set, and modules are functioning, but the system is not 
operating properly, contact “Keysight Support, Services, and Assistance” 
on page 70.
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Part Replacement and Location Information 

There are many other repair and calibration options available from the Keysight 
Technologies support organization. These options cover a range of service 
agreements with varying response times. Contact Keysight for additional 
information on available service agreements for this product.

Replaceable Parts 

Special options are built to order, so long lead times may be encountered when 

ordering replacement parts. For parts that are not listed in the following 

table, refer to “Keysight Support, Services, and Assistance” on page 70.

Description Keysight 
Part Number

Millimeter Head Interface Bd N5261-60101

DC Power Bd N5261-60102

RF/LO Bias/ALC Bd N5261-60103

Preamplifier Bias Bd N5261-60104

LED Bd, Front Panel N5261-60005

Test Set Controller Bd N5261-60006

RF 4-way Divider N5262-80003

RF Detector 33330-80021

Coax Cable, Sloped Attenuator N5262-20033

DC Power Supply 0950-4729

RF Isolator, 20 GHz 0955-1595

Preamplifier 5087-7750

RF/LO Amplifier 5087-7771

Coax Attenuator (3 dB) 0955-0246

Coax Attenuator (6 dB) 0955-0243

Coax Attenuator (7 dB) 0955-0242

RF Directional Coupler (2-20 GHz) 0955-0148

RF Switch, SPDT Solid State 5087-7733

Hex Nut 0140-0084

Lock Washer 2190-0067

Fuse 5 A/250V 2110-0709

Cable, IF MUX, front panel 8121-0150

Cable, IF MUX, rear panel 8120-8483
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Figure 27 Test Set Diagram
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Figure 28 RF and LO Block Diagram1

1. Refer to Figure 27 on page 38 for IF paths.
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Figure 29 Signal Routing 2-Port
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Figure 30 Top View
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Figure 31 Sloped Attn. Cable Assembly

Figure 32 Top Front View 
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Figure 33 Bottom View
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Theory of Operation 

Functional Block and Assembly Information

The N5261AH60 routes PNA-X LO and RF signals to a millimeter-wave 
module. This allows the PNA to up-convert for a millimeter-wave source and 
down-convert a received millimeter-wave frequency to an IF frequency of 
8.3 MHz. It also provides the DC power for the millimeter-wave module. The 
following components are used in the N5261. Refer to the block diagrams, 
Figure 27 through Figure 29 beginning on page 38.

Test Set Control Board (N5261-60006)
The Test Set Control board (N5261-60006) is a surface mount, printed circuit 
assembly (PCA) that provides a connection to the power supply and the PNA 
Test Set I/O. The PNA sends address and data commands which are read by 
the test set controller for selecting the switch paths of the RF and IF switch 
paths. The front panel “Active” and port LEDs are only on when the PNA has 
addressed the N5261H60 Millimeter Head Controller. The rear panel fan is on 
when the Controller board supplies are operational. 

Interface Board (N5261-60101)

The Interface board is installed on top of the test set controller board. It 
provides switch drive signals and voltage for the solid-state switch that select 
RF Output to one of the front panel mm-module RF Outputs ports. The board 
also provides DC voltage and a CPLD programmed device that enables 

N5261AH60 Millimeter Head Controller operation.

LED Board (N5261-60005)

Two LED board assemblies are mounted to the front panel. The top LED 
board indicates the Source Path (amber/yellow color), or Receiver Path 
(green colored) shown as "S" and "R" for each port. The bottom LED board 
indicates the DC power is on (green). If an over-current condition occurs on 
the millimeter-wave module the LED will be amber/yellow), which could be a 
result of a shorted interface cable or damaged millimeter-wave module. The 
LED board assemblies are connected to the test set controller board by 
ribbon cables.

DC Power Board (N5261-60102)

The DC Power board provides connection to the power supply and self 
recovering fuses for each millimeter-wave module supply (+12 volt) on the 
front panel. The fuses are reset when the N5261AH60 is turned off.
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Power Supply (0950-4729)

The power supply (0950-4729) coverts the AC line voltages to DC. This is an 
automatic line voltage selecting power supply. The AC line voltage (100 to 240 
V @ 50/60 Hz) is provided from the line module located on the rear panel.

Isolators (0955-1595)

Isolators are installed in the LO Output RF path for each port. These 10 watt 
isolators maximizes the LO power input to the millimeter-wave modules over a 
frequency range of 8 to 19 GHz.

LO and RF Preamplifier (5087-7750)

A preamplifier installed in the LO and RF Input path provides a higher RF power 
level required for the LO and RF Amp.

RF and LO ALC Amplifier (5087-7771)
The Mod/Amp has adjustable gain that provides ALC leveling for the front 
panel RF and LO Output signals. Adjustments are made on each Mod/Amp to 
set the output power (R3). The output of each amplifier is connected to a 
coupler, and with a detector for ALC, the mod/amps provide RF and LO 
leveling. Each Mod Amp has a Bias board (N5261-60103) installed on top that

 provides the power supply connection and circuitry for setting the gain of the 
amplifier (R3) and an SMB Input to the modulator.

Attenuator, 7 dB (0955-0242)
This attenuator is used at the LO Input port to provide a good match and set 
the LO Input level for the preamplifier. 

Attenuator, 6 dB (0955-0243)
The 6 dB attenuators are used to attenuate the RF and LO power to the ALC 
detector to set the RF level for linear operation. 

Attenuator, 3 dB (0955-0246)
The 3 dB attenuators are used in the SRC 1 Input Mod/Amp Inputs to provide a 
good match and ensure it does not exceed +15 dBm. 

Coupler (0955-0148)
Directional couplers with 10 dB coupling factor are used for ALC feedback for 
RF and LO Output leveling.
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Slope Attenuator Cable Assy (N5262-20033)
A slope pad is installed on the leveling coupler of the RF Out path to 
compensate for the RF switch loss at higher frequencies.

Power Divider (N5262-80003)
A four-way power divider provides each Port LO Output from the LO amplifier 
with approximately 7.2 dB attenuation for each LO Out. Two 50 ohm 
terminators are installed on the unused N5261A divider paths. If a system is 
configured with a unused port (a 1-Port reflection system for example) the front 
panel LO Output ports are to be terminated with a 50 ohm load (1810-0118). 
This keeps the power divider balanced and prevents an “open” reflective signal 
from entering the power divider and mixing with the RF signal.

RF Switch (5087-7733)
A solid-state switch with internal 50 ohm termination is used for switching the 
RF Output path for Ports 1 and 2. This switch is controlled by the test set 

interface boards.
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Troubleshooting, DC Level
For assistance refer to “Keysight Support, Services, and Assistance” 
on page 70.

If the test set is not operating properly, use the following procedures to aid in 
isolating the problem. Refer to the “Test Set Diagrams and Graphics” starting 
on page 38. 

Power Supply and Fans

1. Verify the front panel Standby switch is operational.

a. The rear panel fan and front panel DC Power LEDs should be on
when the Standby switch is in the on position.

2. AC Line voltage checks.

a. Ensure the proper AC line voltage is present at the instrument line
cord.

b. Remove the AC power cord from the instrument. Check the
instrument AC line module 5 amp fuse, as shown in Figure 4 on
page 10.

c. Remove the instrument bottom cover. Near the rear panel are two
fuse holders, remove the 8 amp fuses and verify that they are
operational. See Figure 33 on page 43.

Troubleshooting the Test Set 

Test Set Operation Check

This chapter, “Troubleshooting the Test Set,” contains service information for a 
standalone N5261AH60 controller test set.

The following procedure verifies the test set without system components. 
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Measure the +12 Vdc (red wires) on the DC Power board. If the +12 Vdc is 
present, replace the DC power cable from the front panel (N5652-60001). 
If the +12 Vdc is not present go to step e.

d.

Verify that the supply LED indicators on the Test Set Control Board
(N5261-60006) are on. If they are, replace the DC Power Board
(N5261-60002). Refer to Figure 30 on page 41. If the LEDs not off, refer to
“Troubleshooting the Test Set” on page 47.

e.

4. Internal DC Power checks.

a. Set the Standby switch to the Standby position.

b. Remove the top cover and connect the AC power cord. No fans or 
DC power LEDs should be on.

c. Set the Power Switch to the on position. Both rear panel and 
internal power supply fans should be operational; the front panel DC 
Power LEDs should be on. If the DC Power LEDs are off, measure the
+12 Vdc pins on the front panel connectors. Refer to “Test Set I/O 
Commands” on page 53.

d. Ensure the Controller board DC Supply indicator LEDs are on. If not, 
suspect power supply (0950-4727) or front panel Standby switch. 
Using a DVM measure the power supply terminal connections. Refer 
to the label on the power supply for voltages on the terminals 
screws. 

Inspect the DC Power board (N5261-60002) connections.c.

External DC Power checks.3.

a. Verify DC voltage levels on each of the front panel DC power connectors.

Figure 37 

Pins 1 & 3 = +12 V (± 0.8 V), Pins 4 & 6 = ground

Front Panel MM Module DC Power Connector

If no DC voltages are present at the front panel, remove the 
top and bottom covers.

b.
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3. Move the DC Power board ribbon cable to the Source/Receiver Status LED
board, if the over current LEDs are still on replace the DC Power Board
(N5261-60002). If the LEDs are off replace the DC Power LED Board
(N5261-60005).

Front Panel Active and Port Status LED

Front Panel Receiver and Source Indicator LED check. If the LED indicators are 
not operating, verify the ribbon cable connection and ensure the rear panel test 
set interface cable is connected securely. Proceed to the next section for 
further troubleshooting before replacing the front panel board.

1. Connect the Test Set I/O cable (N4011-21002) from the analyzer to the 
test set.

2. Using the I/O command values, confirm the correct address and data 
values are used, refer to Table 13 on page 58.

3. Front Panel R and S indicator LED Check.

a. Verify that at least two of the Controller Status LEDs are on.

b. If none are on, remove the Switch Driver board and recheck. If still 
no indication, replace the Controller board.

c. If the Controller Status LEDs and the front panel Active LED is on, 
suspect the front panel LED board or the ribbon cable. Replace as 
needed. You can move the ribbon cable connection to the DC power 
board and verify if the problem is the Port Status LED board, or use 
the ribbon cable from the DC power board to verify if the problem is 
the ribbon cable. 

Over Current LEDs are On (amber)

1. Remove all millimeter module connections from the front panel. If the over
current LEDs are off, suspect the millimeter module or the DC Power Bias
cable. If the LEDs are on continue with step 2.

2. Verify that the +12 Vdc on the front panel DC Power connectors is not
shorted to ground. Refer to “Service Information” on page 37. If it is
shorted to ground, replace the front panel DC Power cable (N5652-60001)
or the DC Power Board (N5261-60002). If it is not shorted to ground
continue to step 3.

e. If the voltages on the power supply are correct, lift the Interface
board. If the Controller board DC Supply LEDs are on, disconnect
switches (J60 & J61) and amp cables (J10, 11, 12 and 14) to the
Interface board and re-install the board. If the indicator LEDs are on,
suspect the switch or amplifier.

f. If the fan is not working and all Controller board DC Supply LEDs are
on, replace fan.
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Troubleshooting, RF Level

If the test ports are not switching, or fail the “Test Set Operation Check” on 
page 47, the following procedures can be used to verify the failure. The 
procedures assume power supplies, controller board and front panel LEDs are 
working. Suspect the switch Interface board, ribbon cable connection or RF 
switch. 

1. Inspect the ribbon cable connections from the RF switches to the Switch 
Interface board (N5261-60001).

2. Start by measuring the power at SRC1 continuing through the RF Amp, 
Directional Coupler, and Solid State Switch. If you find incorrect power 
levels and suspect a component has failed, verify the DC voltages.
If you suspect the RF Amp (5086-7771), substitute the LO Amp (5086-7771) 
to verify the failure. The RF Amp uses a leveling circuit with directional 
coupler and detector that also can be checked before replacing the RF Amp. 
You may also substitute the Directional Coupler and Detector from the LO 
Amp section. If the RF Amp is replaced a gain calibration must be preformed.

3. If you suspect the Solid State Switch (SW1) confirm that one of its two LEDs 
toggle on/off when you send a Test Set I/O command. Refer to
“Measure RF OUT (Gain and Power)” on page 56 and Table 13 on page 58.

4. Substitute a known good switch, or connect a known good wire-harness 
cable, and retest. Replace if necessary. 
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LO Out Failure

1. If one of the LO ports are working, suspect the Power Divider.

2. If none of the port are working, start by measuring the power at LO IN,
continuing through the pre-amplifier, LO Amp, Directional Coupler and
Power Divider. If you find incorrect power levels and suspect a component
has failed verify the DC voltages. Replace the failed component.

If you suspect the LO Amp (5086-7771) substitute the RF Amp
(5086-7771) to verify the failure. The LO Amp uses a leveling circuit with
directional coupler and detector that also can be checked before replacing
the LO Amp. You may also substitute the Directional Coupler and Detector
from the RF Amp section.

REF IF or Test IF Failure

Verify that the front panel Port 1 & 2 REF and IF coax cables are properly 
connected to the rear panel (A, B, C, and D) and insertion loss is ≤ .25 dB. 
Replace the coax cable if defective. Refer to Figure 27 on page 38.
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Test Set Operation Check

Required Equipment Preparation

— PNA, PNA-L, PNA-X capable of 20 GHz. (The required Test Set I/O interface 
is included with all models). The PNA, PNA-L or PNA-X will be referred to as 
the PNA throughout this procedure. 

— Two RF flexible cables with 3.5 mm male connectors (5062-6696 or 
equivalent). One cable must be long enough to comfortably connect 
between the PNA and the rear panel of the test set.

— Three SMA or 3.5 mm adapters (female to female)

— Voltmeter

— Power sensor and compatible power meter. The power sensor must be 
capable of measuring from −10 dBm to +15 dBm at a frequency of 8 GHz. A 
E4413A power sensor may be used.

Power Sensor and Power Meter Preparation

The power sensor and power meter must be prepared to make measurements 
at 8 GHz. This may include calibrating the power sensor with the meter and 
entering a calibration factor for 8 GHz.

PNA and Test Set Preparation

1. Connect the Test Set I/O cable from the PNA to the test set.

2. Turn on the PNA and the test set.

3. The PNA must be in “Standard PNA” mode.To check the mode, select
Utility > System > Configure > Millimeter Module Configuration. The
Millimeter Module Configuration window will be displayed. Next, select
[Module Config]. Click on “Standard PNA” in the list of Available
Configuration(s) then click OK.

This chapter contains service information for a standalone N5261AH60 controller 
test set. The following procedure verifies the test set without mm-module 
components.



53   Keysight N5261AH60 User’s and Service Guide

Service Information 

-

Test Set I/O Commands 

The Service Information requires the use of Test Set I/O commands. 
These commands are issued by the PNA.

Controlling the Test Set using Test Set I/O Commands

A Test Set I/O command may be used when the PNA is connected to the Test 
Set via the Test Set I/O cable. Commands may control the test set or read data 
from the test set. The GPIB command processor utility, in the network analyzer 
software, is used to communicate over the Test Set I/O connector.

It is recommended to use a USB keyboard with a PNA when using the 
command processor.

Using the GPIB command processor 

— Select Utility > System > Configure > SICL/GPIB/SCPI, then select SCPI 
Command Processor Console. In the dialog box type the command text and 
then Enter on the keyboard to execute the command. 

— A write command is of the form: cont:ext:test:data n,m   "n" is the address 
and "m" is the data to be written. Typically these values may be any number 
up to three digits in length.

— A read command is of the form: cont:ext:test:data? n    "n" is the address. A 
read command returns a single numeric value.

— Pressing F3 on the keyboard will recall a previously sent command line for 
editing. 

— As a check, send the command: cont:ext:test:data? 0   <enter>. A 61 should 
be returned, depending on the model number of the test set.

— An active command processor window may be minimized via the "_" in the 
upper right hand corner of the window. To access a minimized command 
processor window, minimize the PNA window. Select File > Minimize 
Application.

PNA Normalization Calibration

This procedure prepares the PNA to for path loss measurements.

1. Select [Preset] on PNA.

2. Set the Start and Stop frequencies (8 - 20 GHz).

3. Set the power output level to -10 dBm.

4. Set to measure S12.

5. Connect an RF cable to PNA Port 1. Connect a second RF cable to PNA
Port 2.

6. Connect the two RF cables together with an adapter.

7. Normalize the trace, Select [Memory] > Normalize or select [Data] >
Normalize. You will see a flat line at 0 dB.

8. Remove the adapter between the RF cables.
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Test Set I/O Command List

The following commands are available for controlling/reading the test set. 
The step-by-step commands in the Service Information procedure require the 
use of these commands. The user is required to select the appropriate 
command, depending on the port or function under test.

Read commands involve a single number, an address. Write commands involve 
two numbers, address and data.

The amber Source LEDs are controlled separately from the switch for the RF 
OUT paths. Receiver LEDs are always ON since they are not switched.

Table 12 I/O Commands

0 address for reading two digits from model number of the test set (+61)

32,0 turns on ALC for both SRC1 (Port 1 and 2) 

32,1 turns off ALC for SRC1 (Port 1 and 2) 

0,1 SRC1 IN to Port 1 RF OUT

0,2 SRC1 IN to Port 2 RF OUT 

64,17 turns on Receiver and Source LED’s for Port 1 (Port 2 LEDs off)

64,34 turns on Receiver and Source LED’s for Port 2 (Port 1 LEDs off)
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Measure LO OUT (Gain and Power)

Prepare the PNA to measure S12 with a normalization calibration. Refer to 
“PNA Normalization Calibration” on page 53. Use a frequency range of 8 to 
20 GHz and a power level of −10 dBm. The cable on PNA Port 2 must be 
long enough to reach the rear panel of the test set. 

1. Connect the PNA Port 2 cable to the rear panel LO IN.

2. Connect PNA Port 1 to Port 1 LO OUT on the test set. Verify the LO Output
gain is approximately 20 dB. The trace should be within 10 dB of “flat” and
have no significant holes or discontinuities. Refer to Figure 34 below.

3. Move PNA Port 2 cable to Port 2 LO OUT and confirm a similar result.

4. Select [Sweep] > Sweep Type > CW Time. Set the sweep time to 10
seconds.

5. Disconnect the cable from LO IN and measure the power at the end of the
cable using a power sensor. The power should be in the −8 to −12 dBm
range. Adjust the PNA power output level if needed.

Reconnect the cable to LO IN.

6. Measure the Port 1 LO OUT power using a power meter. The power should
be +12 dBm (± 2 dB). Measure LO OUT for the other ports on the test set.

Figure 34 LO Output Gain with −10 dB Input 
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Measure RF OUT (Gain and Power)

The following procedure measures gain.

Prepare the PNA to measure S12 with a normalization calibration. Refer to 
“PNA Normalization Calibration” on page 53 with a frequency range of 8 to 20 
GHz and a power level of 2 dBm.

1. Connect the PNA Port 2 cable to rear panel SCR 1 IN.

2. Connect the Panel PNA Port 1 cable to front panel Port 1 RF OUT.

3. Issue the Test Set I/O commands 0,1 (enable ALC and output to Port 1). 
Verify that the gain is greater than 10 dB at all frequencies and there are 
no holes or significant discontinuities in the trace. Refer to Figure 35 on 
page 57.

4. Issue the Test Set I/O command 32,1 (disable ALC on Port 1). Verify that 
the gain increases at all frequencies and that there are no holes in the 
trace. Refer to Figure 36 on page 57.

5. Move front panel cable connection to Port 2 RF Out.

6. Repeat Step 3 and 4, but change issue commands to 32,0 and 0.2 for 
Step 3.

7. Issue command 32.0 in preparation for the power check. 

The following procedure measures the power output level.

1. Select [Sweep] > Sweep Type > CW Time. Set the sweep time to 10
seconds.

2. Connect PNA Port 2 cable to a Power Sensor.

3. Set the PNA power output level to get a reading at -6 (± 1 dBm).

4. Connect the PNA Port 2 cable to SRC1 RF IN on the rear panel.

5. Issue the Test Set I/O commands 32,0 and 0,1 (enable ALC and output to
Port 1).

7. Move the Power Sensor to Port 2 RF OUT.

8. Issue the Test Set I/O command 0,2. Confirm the RF OUT is
+12.5 dBm (± 1.5 dB).

6. Measure the Port 1 RF OUT power using the power sensor. Confirm that
RF OUT is +12.5 dBm (± 1.5 dB).
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Figure 35 RF Output Gain with +2 dBm ALC On

Figure 36 RF Output Gain with +2 dBm ALC Off
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Measuring Test IF and REF IF Path Loss on the N5261AH60

The IF paths for the test set are not switched. See Figure 27 on page 38.

The cable connected to PNA Port 1 must be long enough to reach the rear 
panel of the test set.

1. Prepare the PNA to measure S12 with a normalization calibration. Select 
a frequency range of 8 to 9 MHz and a power level of −20 dBm. See “PNA 
Normalization Calibration” on page 53.

2. Measure the IF signal paths listed below. Connect PNA Port 2 cable to the 
test set front panel and the PNA Port 1 cable to the rear panel IF OUT. 
Maximum loss should be < 3 dB. 

— Port 1 TEST IF to A (rear panel)

— Port 1 REF IF to C (rear panel)

— Port 2 TEST IF to B (rear panel)

— Port 2 REF IF to D (rear panel)

Table 13 IF Path Measurement 

From: TEST IF 
Front Panel

To: N5261A Rear 
Panel IF OUT

Max Path Loss (dB)

Port 1 TEST IF A 0.25

Port 2 TEST IF B 0.25

Port 1 REF IF C (R1) 0.25

Port 2 REF IF D (R2) 0.25
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Test and Adjustment Procedures
The “Test Set Operation Check” on page 47 should be performed whenever any 
active electronic part is replaced in the test set. 

Additional procedures are required when certain components are replaced. 
Table 14 indicates when additional procedures are required. The additional 
procedures depend on the location of the replaced component.

The additional procedures are indicated as A and B in Table 14. 

The procedures referenced above may be found on the following pages. 
Many of the steps require familiarity with the “Test Set Operation Check” 
section beginning on page 52.

Table 14 Additional Required Procedures for Assemblies Replaced

Description of the Replaced 
Component

Keysight 
Part Number

Location:
Ports 1 & 2 RF 
Section1

Location: 
LO Section

General Location

Millimeter Head Interface Bd N5261-60101

Test Set Controller Bd N5261-60006

RF/LO Bias/ALC Bd N5261-60103 A B

Preamplifier Bias Bd N5261-60104 B

RF 4-way Divider N5262-80003 B

RF Detector 3333-80021 A B

Coax Cable, Sloped Attenuator N5262-20033 A

Preamplifier 5087-7750 B

RF/LO Amplifier 5087-7771 A B

RF Directional Coupler 0955-0148 A B

RF Switch, SPDT Solid State 5087-7733 A

1. Refer to Figure 27 thru Figure 29 and Figure 31 thru Figure 33 to determine part location.
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Adjust RF and LO ALC Levels

Background

When a component is changed in an RF or LO signal path, it is often necessary 
to adjust the ALC level for the path. See Table 14 on page 59 for required 
adjustments when a part is replaced.

PNA and Power Sensor Preparation

A power sensor and power meter must be prepared to make measurements at 
8 GHz. This may include calibrating the power sensor with the meter.

1. Set the PNA to measure S12.

2. Set for CW sweep at 8 GHz.

3. Set the sweep time to 5 seconds.

4. Set the power to -8 dBm.

ALC level for RF Port 1 (Procedure A)

1. Prepare the PNA and Power Sensor as described above.

2. Connect PNA Rear Panel RF Port to Test Set SRC 1 IN.

3. Connect the power sensor to Test Set front panel Port 1 RF OUT.

4. Issue the Test Set I/O commands: 32,0 and 0,1 (ALC on and Port 1 RF 
OUT).

5. Identify the “Port 1 & 2 ALC RF Amp”, see Figure 30 on page 41. Identity 
R7 and R3, see Figure 38 on page 61.

6. Adjust R7: turn full CW (may require up to 30 turns) then 5 turns CCW.

7. Adjust R3: adjust for a reading on the power meter of 12.5 dB (± 0.1 
dBm).

8. Perform “Measure RF OUT (Gain and Power)” check found on page 56. 
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ALC level for LO (Procedure B)

1. Prepare the PNA and Power Sensor as described on page 60.

2. Connect PNA Port 2 to LO IN on the rear panel of the test set.

3. Connect the power sensor to Port 1 LO OUT.

4. Identify the “LO ALC Amp,” R7 and R3, see Figure 30 and Figure 38.

5. Adjust R7: turn full CW (may require up to 30 turns) then 5 turns CCW.

6. Adjust R3: adjust for a reading on the power meter of 12 dB (± 0.1 dBm).

7. Perform “Measure LO Out (Gain and Power)” check found on page 55. 

Figure 38 Mod Amp Adjustments

R3  R7
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Safety and Information 

Introduction

Review this product and related documentation to familiarize yourself with 
safety markings and instructions before you operate the instrument. 

This product has been designed and tested in accordance with accepted 
industry standards, and has been supplied in a safe condition. The 
documentation contains information and warnings that must be followed by 
the user to ensure safe operation and to maintain the product in a safe 
condition.

Safety Earth Ground

This is a Safety Class I Product (provided with a protective earthing 
ground incorporated in the power cord). The mains plug shall only be 
inserted in a socket outlet provided with a protective earth contact. 
Any interruption of the protective conductor inside or outside of the 
product is likely to make the product dangerous. Intentional 
interruption is prohibited.

Always use the three prong AC power cord supplied with this product. Failure 
to ensure adequate earth grounding by not using this cord may cause 
product damage and the risk of electrical shock.

Declaration of Conformity

Declarations of Conformity for this product and for other Keysight products 
may be downloaded from the Keysight Regulatory Website. Click on 
"Declarations of Conformity" and enter your product number to find the latest 
Declaration of Conformity statement. http://regulations.about.keysight.com

Statement of Compliance

This instrument has been designed and tested in accordance with CAN/CSA 
22.2 No. 61010-1-04, UL Std No. 61010-1 (2nd Edition).

http://regulations.about.keysight.com/
http://regulations.about.keysight.com/
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Before Applying Power

Verify that the premises electrical supply is within the range of the instrument. 
The instrument has an autoranging power supply.

If this product is not used as specified, the protection provided by the 
equipment could be impaired. This product must be used in a normal 
condition (in which all means for protection are intact) only.

The Mains wiring and connectors shall be compatible with the connector 
used in the premise electrical system. Failure, to ensure adequate earth 
grounding by not using the correct components may cause product damage, 
and serious injury.

Always use the three prong AC power cord supplied with this product. Failure 
to ensure adequate earth grounding by not using this cord may cause 
product damage and the risk of electrical shock.

This product is designed for use in Installation Category II and Pollution 
Degree.

Before switching on this instrument, make sure the supply voltage is in the 
specified range.

Verify that the premise electrical voltage supply is within the range specified 
on the instrument.

Ventilation Requirements: When installing the instrument in a cabinet, the 
convection into and out of the instrument must not be restricted. The ambient 
temperature (outside the cabinet) must be less than the maximum operating 
temperature of the instrument by 4 °C for every 100 watts dissipated in the 
cabinet. If the total power dissipated in the cabinet is greater than 800 watts, 
forced convection must be used.
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Danger of explosion if battery is incorrectly replaced. Replace only with 
the same or equivalent type recommended. Discard used batteries 
according to manufacturer’s instructions.

For continued protection against fire hazard replace line fuse only with 
same type and rating. The use of other fuses or material is prohibited.

These servicing instructions are for use by qualified personnel only. To 
avoid electrical shock, do not perform any servicing unless you are 
qualified to do so.

The opening of covers or removal of parts is likely to expose the user to 
dangerous voltages. Disconnect the instrument from all voltage 
sources before opening.

No operator serviceable parts inside. Refer servicing to qualified 
personnel. To prevent electrical shock, do not remove covers.

The detachable power cord is the instrument disconnecting device. It 
disconnects the mains circuits from the mains supply before other 
parts of the instrument. The front panel switch is only a standby switch 
and is not a LINE switch (disconnecting device).

Connector Care and Cleaning Precautions

Remove the power cord to the instrument. To clean the connectors use alcohol 
in a well ventilated area. Allow all residual alcohol moisture to evaporate, and 
fumes to dissipate prior to energizing the instrument. 
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To prevent electrical shock, disconnect the Keysight N5261A or 
N5262A from mains electrical supply before cleaning. Use a dry cloth 
or one slightly dampened with water to clean the external case parts. 
Do not attempt to clean internally.

If flammable cleaning materials are used, the material shall not be 
stored, or left open in the area of the equipment. Adequate ventilation 
shall be assured to prevent the combustion of fumes, or vapors.
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Regulatory Information

This section contains information that is required by various government 
regulatory agencies.

Instrument Markings

The instruction documentation symbol. The product is marked with this symbol when it is 
necessary for the user to refer to the instructions in the documentation.

The AC symbol indicates the required nature of the line module input power.

This symbol indicates separate collection for electrical and electronic equipment, mandated 
under EU law as of August 13, 2005. All electric and electronic equipment are required to be 
separated from normal waste for disposal (Reference WEEE Directive, 2002/96/EC).   

This symbol indicates that the power line switch is ON.

This symbol indicates that the power line switch is in the STANDBY position.

This symbol indicates that the power line switch is in the OFF position.

This symbol is used to identify a terminal which is internally connected to the product frame or 
chassis.

The CE mark is a registered trademark of the European Community. (If accompanied by a year, it 
is when the design was proven.)

The CSA mark is a registered trademark of the CSA International. 

This mark designates the product is an Industrial Scientific and Medical Group 1 Class A product 
(reference CISPR 11, Clause 5)

This is a marking to indicate product compliance with the Canadian Interference-Causing 
Equipment Standard (ICES-001).

Direct Current.

IP 2 0 The instrument has been designed to meet the requirements of IP 2 0 for egress and operational 
environment.

The RCM mark is a registered trademark of the Australian Communications and Media Authority

Indicates the time period during which no hazardous or toxic substance elements are expected to 
leak or deteriorate during normal use. Forty years is the expected useful life of the product. 

ICES/NMB-001 
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This symbol on all primary and secondary packaging indicates compliance to China standard GB 
18455-2001.

South Korean Certification (KC) mark; includes the marking's identifier code which follows the 
format: MSIP-REM-YYY-ZZZZZZZZZZZZZZ.
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Battery Collection

Do not throw batteries away but collect as small chemical waste, or in 
accordance with your country’s requirements. You may return the battery to 
Keysight Technologies for disposal. Refer to “Contacting Keysight” on page 70 
for assistance.

Electrical Safety Compliance

SAFETY

Complies with European Low Voltage Directive 2014/35/EU

— IEC/EN 61010-1:2010, 3rd Edition 

— Canada: CSA C22.2 No. 61010-1-12

— USA: UL std no. 61010-1, 3rd Edition 

— Acoustic statement (European Machinery Directive 2022/42/EC, 1.7.4.2U)
Accoustical noise emission
LpA<70 dB 
Operator position
Normal operation mode
Per ISO 7779

EMI and EMC Compliance

EMC

Complies with European EMC Directive 2014/30/EU

— IIEC 61326-1:2012/EN 61326-1:2013

— CISPR Pub 11 Group 1, class A

— AS/NZS CISPR 11:2011

— ICES/NMB-001
This ISM device complies with Canadian ICES-001.
Cet appareil ISM est conforme a la norme NMB du Canada.

— South Korean Class A EMC declaration: This equipment is Class A suitable 
for professional use and is for use in electromagnetic environments outside 
of the home.

A 급 기기 ( 업무용 방송통신기자재 ) 이 기기는 업무용 (A 급 ) 전자파적합기

기로서 판 매자 또는 사용자는 이 점을 주 의하시기 바라 며 , 가정외의 지역

에서 사용하는 것을 목적으 로 합니다 .
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Electrostatic Discharge Protection
Electrostatic discharge (ESD) can damage or destroy electronic components. 
The product is shipped in materials that prevent damage from static, and 
should only be removed from the packaging in an anti-static area ensuring that 
the correct anti-static precautions are taken. 

Two types of ESD protection are listed below. Purchase acceptable ESD 
accessories from your local supplier.

— Conductive table-mat and wrist-strap combination

— Conductive floor-mat and heal-strap combination

Both types, when used together, provide a significant level of ESD protection. 
To ensure user safety, static-safe accessories must provide at least 1 MΩ of 
isolation from ground. 

These techniques for a static-safe work station should not be used 
when working on circuitry with a voltage potential greater than 500 
volts.
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Keysight Support, Services, and Assistance

Service and Support Options

There are many other repair and calibration options available from the Keysight 
Technologies support organization. These options cover a range of service 
agreements with varying response times. Contact Keysight for additional 
information on available service agreements for this product. 

Contacting Keysight

Assistance with test and measurement needs, and information on finding a 
local Keysight office are available on the Internet at:
http://www.keysight.com/find/assist

You can also purchase accessories or documentation items on the Internet at: 
http://www.keysight.com/find

If you do not have access to the Internet, contact your field engineer.

In any correspondence or telephone conversation, refer to the Keysight 
product by its model number and full serial number. With this information, 
the Keysight representative can determine the warranty status of your unit.

Shipping Your Product to Keysight for Service or Repair

IMPORTANT Keysight Technologies reserves the right to reformat or replace the internal 
hard disk drive in your analyzer as part of its repair. This will erase all user 
information stored on the hard disk. It is imperative, therefore, that you make 
a backup copy of your critical test data located on the analyzer’s hard disk 
before shipping it to Keysight for repair.

If you wish to send your instrument to Keysight Technologies for service or 
repair:

— Include a complete description of the service requested or of the failure and 
a description of any failed test and any error message.

— Remove and retain the front handles and all rack mount hardware. The 
analyzer should be sent to Keysight in the same configuration as it was 
originally shipped.

— Remove and retain the front handles and all rack mount hardware. The 
analyzer should be sent to Keysight in the same configuration as it was 
originally shipped.

— Contact Keysight for instructions on where to ship your analyzer.

http://www.home.agilent.com/agilent/editorial.jspx?cc=US&lc=eng&ckey=2073913&nid=-35734.0.00&id=2073913&cmpid=zzfindassist
http://www.home.keysight.com/agilent/editorial.jspx?cc=US&lc=eng&ckey=2073913&nid=-35734.0.00&id=2073913&cmpid=zzfindassist
http://www.home.keysight.com/agilent/editorial.jspx?cc=US&lc=eng&ckey=2073913&nid=-35734.0.00&id=2073913&cmpid=zzfindassist
http://www.home.keysight.com/agilent/editorial.jspx?cc=US&lc=eng&ckey=2073913&nid=-35734.0.00&id=2073913&cmpid=zzfindassist
http://www.home.agilent.com/agilent/commonlanding.jspx?lc=eng&cc=US&cmpid=92800
http://www.home.keysight.com/agilent/commonlanding.jspx?lc=eng&cc=US&cmpid=92800
http://www.home.keysight.com/agilent/commonlanding.jspx?lc=eng&cc=US&cmpid=92800
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